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Commercial Design Using Autodesk Revit Architecture 2011

Lesson 3
Office Building: FLOOR PLAN (First Floor)::

In this lesson you will draw the first floor plan of an office building. The office building will
be further developed in subsequent chapters. It is recommended that you spend adequate
time on this lesson as later lessons build on this one.

Project Overview

A program statement is created in the pre-design phase of a project. Working with the client
(or user group), the architect gathers as much information as possible about the project
before starting to design.

The information gathered includes:
® Rooms: What rooms are required?
e Size: How big the rooms need to be? (E.g., toilets for a convention center are much
bigger than for a dentist’s office.)

e Adjacencies: This room needs to be next to that room. (E.g., the public toilets need to
be accessible from the public lobby.)

With the project statement in hand, the architect can begin the design process. Although
modifications may (and will) need to be made to the program statement, it is used as a goal
to meet the client’s needs.

You will not have a program statement, per se, with this project. However, the same
information will be provided via step-by-step instructions in this book.

Project Overview:

You will model a three-story office
building located in a rural setting.
Just to the North of the building
site is a medium-sized lake. For the
sake of simplicity, the property is
virtually flat.

The main entry and parking is
from the south side of the
building. You enter the building
into a three-story atrium. Levels 2
and 3 have guard railings that look down into Level 1 in the atrium. The atrium is enclosed
on three sides by full height curtain walls (glass walls). See the image on the front cover.
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This building is not meant to meet any particular building code. It is strictly a tool to learn
how to use Revit. Having said that, however, there are several general comments as to how
codes may impact a particular part of the design.

The floor plans are mostly open office areas with a few smaller rooms for toilets, private
offices, work and break rooms, etc. These areas have several “punched” window openings
on the exterior walls (punched as opposed to ribbon windows).
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FIGURE 3-1.1 Level 1 floor plan sketch
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FIGURE 3-1.2 South elevation sketch
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Office Building: FLOOR PLAN (First Floor)

Exterior Walls

You will begin the first floor plan by drawing the exterior walls. Like many projects, early on
you might not be certain what the exterior walls are going to be. So, we will start out using
the generic wall styles. Then we will change them to a custom wall style (that you will create)
once we have decided what the wall construction is.

Adjust Wall Settings:

1. Start a new project using the Default template, and then select the Wall tool from
the Rzbbon.

The previous chapter started with a more complete template. This chapter starts from the
default template so you have the opportunity to learn how to create things such as the room
finish schedule so you better understand how Revit work.

2. Make the following changes to the wall options (Figure 3-2.1):
o Wall style: Basic Wall: Genetic — 12”
e Height: Unconnected
e Height: 36" 0”7
® [ ocation Line: Finish Face: Exterior

= H (g~~~ = f\ A A B0 EE =5 Fﬁ' 5 Autodesk Revit Architecture 2011
Madify | Place Wall

o .
i Koo 8 B PRl == B - = 0 A2 960-|

= =] ] v oo el
Modify | [THI O Cut =0 2 o == 00 ol = IS PO S e S
= AR A A i =2 x| = \t/}\' & 8l |
Select | Properties | Clipboard Geometry Modify |\."iew Measure Createl Draw I
Modify | Place Wall | Height Uncont » 36" 0" | Location Line: Finish Face: Ext | [¥]Chain Offset: 0' 0" [|Radius: | 1' 0" 1
Properties ] :
1
l:l Basic Wall - )

Generic - 127

- i
New Walls v] Edit Type

Constraints E P ;
. i i ini : | i N B e e P et .
biga. -t FinisheEace: Exteripr ﬁ|,' o —— — e 4

FIGURE 3-2.1 Ribbon, Options Bar and Type Selector: Wall tool active

Draw the Exterior Walls:

3. Draw the walls shown in Figure 3-2.2. Make sure your dimensions are correct. Use
the Measure tool to verify your dimensions. Do not add the dimensions.

INOTE: If you draw in a clockwise fashion, your walls will have the exterior side of the wall correctly
positioned. You can also use the spacebar to toggle which side the exterior face is on.
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FIGURE 3-2.2 Exterior walls

Create a Custom Wall Style:

Revit provides several predefined wall styles, from metal studs with gypsum board to
concrete block and brick cavity walls. However, you will occasionally need a wall style that
has not yet been predefined by Revit. You will study this feature next.

First, you will take a quick look at a more complex wall type that Revit provides so you can
see how they are set up.

4. With the Wall tool selected, pick the wall type:
Basic Wall: Exterior — Brick on CMU, from
the Type Selector drop-down list. (See image at

1 | Select | Build
rlght') Modify | Place Wall Height: Uncont v 36' 0" | Location Line: Finish Face: Ext
Properties B i
5. Click the Edit Type button on the Properties Bcwat 3
Palette (Fig. 3-2.3). — B
=" Exterior - Brick and CMU on MTL. Stud
6. You should be in the Type Properties dialog LTI | q
box. Click the Edit button next to the e ke S
Structure parameter (Figure 3-2.4). T
= Exterior - CMU on M. Stud 1
== Exterior - EIFS on Mtl. Stud 3

Foundation - 12" C: 1 )
L it - bl st aes, gt -»r*-’j
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Office Building: FLOOR PLAN (First Floor)

Basic Wall

Exterior - Brick on CMU

New Walls

v] Edit Type
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Base Offset

o g
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Apply

=) |

Type Properties
Family: ISysbem Family: Basic Wall V] Load...
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Paramneter Value |:
Construction R
Structure Edit...
Wrapping at Inserts Do not wrap
Wrapping at Ends None
Width 1'71/2"
Function Exterior

Coarse Scale Fill Pattern
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URL

Description

Assembly Description

Ext. Wall - Brick Composite

Assembly Code

B2010156

Type Mark

[ << Preview I [

Cancel I

J |

Apply

FIGURE 3-2.3 Properties Palette

FIGURE 3-2.4 Type Properties

7. Finally, you are in the Edit Assembly dialog box. This is where you can modify existing
wall types or create new ones. Click <<Preview to display a preview of the selected

wall type. (Figure 3-2.5)

EXTERIOR SIDE

Edit Assembly =)
Family: Basic Wall
Type: Exterior - Brick on CMU
Total thickness: 1 71 Sample Height: oo 0]
Layers

Function Material Thickness Wraps| =
T 0 L
2| Thermal/Airla Misc, Air Layers (0" 3"
_ 3 | Thermal/AirLa i Insulation/The i0' 3"
4 | Membrane Lay | Vaper/ Moistur 0" 0"
I T A A I | | 5 | Core y : Layers Above Wr: 0" 0"
I A A I I I_I - + "
B | Structure [1] Masonry - Con 0" 75/8
7 | Core y : Layers Below Wr: 0" 0"
8 [Substrate [2] Metal - Furring 0" 15/8" il
INTERICR SIDE
) Com) [ &
Default Wrapping
At Inserts: At Ends:
[Do not wrap '] [None - I

Modify Vertical Structure (Section Preview only)

i Modify Merge Regions Sweeps
] 3
D Assi s Split Region Reveals
o
& View: [Fioor Plan: Modify ty v] [ Preview > ( oK J[ cancel ][ heb

FIGURE 3-2.5 Edit Assembly



Commercial Design Using Autodesk Revit Architecture 2011

Here, the Edit Assembly dialog box allows you to change the composition of an existing wall
or to create a new wall.

Things to notice in the Edit Assembly dialog box (Figure 3-2.5):

10.

11.

12.

13.

The exterior side is labeled at the top and interior side at the bottom.

You will see horizontal rows (i.e., Core Boundary) identifying the core material. The
core material can be used to place walls and dimension walls. For example: the Wa//
tool will let you draw a wall with the interior or exterior core face as the reference
line. On an interior wall you would typically dimension to the face of CMU rather
than to the finished face of gypsum board. This is to work out coursing and give the
contractor the information needed for the part of the wall he will build first.

Each row is called a layer. By clicking on a layer and picking the Up or Down
buttons, you can reposition materials, or layer, within the wall assembly.

Click Cancel in each open dialog box to close them.

Set the wall style back to Basic Wall: Genetic — 12” in the Type Selector.
Click the Edit Type button again on the Properties Palette.

Click Duplicate.

Enter Brick & CMU cavity wall for the new wall type name, and then click OK
(Figure 3-2.6).

[ Mame ﬁ

Mame: | Brick & CMU cavity wall

FIGURE 3-2.6 New wall type name

Click the Edit button next to the S#ucture parameter.
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Office Building: FLOOR PLAN (First Floor)

Using the Insert button and the Up and Down buttons, add the /zyers to your new wall style
as shown below in Figure 3-2.7.

Function Material Thickness
Finish 1 [4] Masonry -Brick 4”
Thermal/Air Layer [3] Misc. Air Layers — Air Space 2"
Thermal/Air Layer [3] Insulation / Thermal Barriers — Rigid 2"
Insulation

Core Boundary Layers above wrap 0”

Structure [1] Masonry — Concrete Masonry Units 8”

Core Boundary Layers below wrap 0”

Finish 2 [5] Metal — Stud Layer 215"

Finish 2 [5] Gypsum Wall Board 5"

FIGURE 3-2.7 New wall layers

Masonry is typically drawn nominally in plans and smaller scaled details. This helps to figure
out coursing for both drawing and dimensioning. For example, 8” concrete block is actually

77",

Also, notice that the CMU, Rigid Insulation, Air Space and Brick add up to 16” in thickness.
This portion of the wall would sit on a 16” concrete block (CMU) foundation wall directly

below.

14. Your dialog should look like Figure 3-2.8. Click OK to close all dialog boxes.

r 3
Edit Assembly =5
L Family: Basic Wall
Type: Brick CMU cavity wal
Total thickness: 1 71/8° Sample Height: 0 0"
Layers
EXTERICR SIDE
Function Material =
[l Finizh1 (4] Iasonry - Brick |
2 | Thermal/Air Lay Misc, Air Layers - Ai 0" 2
3 [ Structure [1] Insulation / Therma 02
4 | Core Y Layers Above Wrap 0" 0"
I I Y I I | 5 | Structure [1] Masonry - Concrete o 8"
4 & | Core vy layers Below Wrap 0 O
7 | Finish 2 [5] Metal - Stud Layer 02172
8 | Finish 2 [5] Gypsum Wall Board 0" 05/8 i
INTERIOR. SIDE
S e
Default Wrapping
At Inserts: At Ends:
[Do not wrap v] lNone ']
Modify Vertical Structure (Section Preview only)
s Modify Merge Regions Sweeps
4 [ »
_ Assign Layers Split Region Reveals
\Q{; View: [Floor Plan: Modify tyf v] [ Preview = ] [ OK ] [ Cancel ] [ Help ]
\

FIGURE 3-2.8 Edit Assembly for new wall type
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The next step is to change the wall type for the walls previously drawn.

15. Select the Modify button on the Rzbbon; this allows you to select elements in your
drawing.

16. Zoom out so you can see the entire plan. Dragging your mouse from one corner to
the other, make a window over the plan to select all the walls.

17. With the walls selected, pick Basic Wall: Brick & CMU cavity wall from the Type
Selector drop down.

TIP: 1f, after selecting all the walls, the Type Selector is not active and does not show any wall types, you probably
have some other elements selected such as text or dimensions. Try to find those elements and delete them (except the
elevation tags). You can also click on the Filter button (located on the Ribbon when objects are selected) and
uncheck the types of elements to excclude from the current selection.

You should notice the wall thickness change, but the
wall cavity lines and hatch are not showing yet. This is A

controlled by the Dezail I evel option for each view.
[ coarse
. . . . 2= Medium
18. Click on Detail Level icon in the lower-left }‘
corner of the Drawing Window, on the 1Vzew =10 IR R w0 «
Control Bar.

ey -

19. Select Medium. Detail Level; Set to Medium

You should now see the brick and CMU thicknesses with hatching. If you did not pay
attention when drawing the walls originally, some of your walls may show the brick to the
inside of the building.

20. Select Modify (or press Esc); select a wall. You will see a symbol appear that allows
you to flip the wall orientation by clicking on that symbol (Figure 3-2.9).

Click this symbol to flip

wall orientation

17 -4 78

FIGURE 3-2.9 Selected Wall; notice some walls have the brick on the interior
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Office Building: FLOOR PLAN (First Floor)

21. Whether you need to adjust walls or not, click on the flip symbol to experiment with
its operation.

T1P: The Flip symbol is always on the exterior side (or what Revit thinks is the exterior side) of the wall.

22. If some walls do need to be adjusted so the brick is to the exterior, do it now. You
will probably have to select the wall(s) and use the Move tool to reposition the walls
to match the required dimensions.

TIP: If you set the “location line”, via the Properties Palette, to "W all Centerline the wall will not move
and mess up the overall dimensions when flipping it. You will want to set the “location line” back to Finish
Face: Excterior when done.

23. Save your Project as ex3-2.rvt.

+»
L ]
+'I'
TIP: You can use the MOVE tool MY o the Ribbon (when a wall is selected) to accurately move walls.

Follow these steps to move an object:
o Select the wall
o Click the Move too!
o Pick any point on the wall
o Start your cursor in the desired direction (don’t click)

o Start typing the distance you want to move the wall and press Enter.

Finally, you will change the three walls at the atrium to be curtain walls (full glass). This will
let lots of light into the atrium and better identify the main entry of the building.

24. Drag a selection window (from left to right) to select the three walls around the
atrium, or hold the Ctrl key on the keyboard and select them.

25. With the walls selected, select Curtain Wall: Curtain Wall 1 from the Type Selector
drop-down.

Your atrium is now surrounded by curtain walls (Figure 3-2.10). In a later lesson we will add
horizontal and vertical mullions to the curtain wall.

You can see your progress nicely with a 3D view. Click the 3D View button on
the O AT. Notice that Revit shows the curtain wall as transparent because it ﬁ
knows the curtain wall is glass. The other walls are shaded on the exterior side

due to the brick pattern that is applied.

26. Save your project as €x3-2.rvt.
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Revit automatically sets the hatch intensity and line weights.
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FIGURE 3-2.10 Completed exercise
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FIGURE 3-2.11 Completed exercise
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Office Building: FLOOR PLAN (First Floor)

Interior Walls

In this lesson you will draw the interior walls for the first floor.

Adjust Wall Settings:
1. Select Home = Build = Wall from the Ribbon.

2. Make the following changes to the wall options on the Rzbbon, Options Bar and Type
Selector (Figure 3-2.1):

o Wall style: Basic Wall: Intetior — 4 7/8” pattition (1-hr)
e Height: Level 2
o [ ocation Line: Wall Centerline

Draw the Interior Walls:

3. Draw a “vertical” wall approximately as shown in Figure 3-3.1. You will adjust its
exact position in step #4.

Step #4 (second click): pick

left side of this wall \

Step #4 (first click): pick the
edge of this wall

FIGURE 3-3.1 First interior wall

4. Select Modify = Edit = Align tool to align it with the edge of

the exterior wall in the atrium (Figure 3-3.1). When you are done, Dl:'
the wall should look like Figure 3-3.2.
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5. Create the same wall for the West side of the atrium
repeating the above steps.

Modify an Existing Wall Type:

Next you will add some additional interior walls. You will be
drawing 8” CMU walls. Revit does have an 8” Masonry wall type
available in the default template file that you started your project
from. However, the thickness for this wall type is 7%”, which is the
actual size of a block. Floor plans are usually drawn nominally (i.e.,

8”) not actual (7%s”). This is done so you can figure out coursing so
minimal cutting is required. Therefore, rather than creating a new
wall type you can simply modify the existing wall type.

Note: some may disagree with this approach. However, these
changes should still be made to this project so you learn more about
how walls work and so all the tasks in this book work as expected
or intended.

FIGURE 3-3.2

6. Select the wall type: Basic Wall: Generic — 8” Masonty.

7. Select the Edit Type button on the Properties Palette to view the wall’s Type Parameters,
and then click Edit next to the S#ucture parameter.

8. Change the masonry thickness from 7%s” to 8” in the Edit Assembly dialog box, and
then select OK to close each dialog (do not close the Properties Palette).

Occasionally Revit will not list dimensions, relative to the walls you want to draw new walls
from, while in the create wall mode. One way to deal with this is to draw temporary Deza:l

Lines to use as a reference. After using the temporary line as a reference you can delete it.

9. Select Annotate = Detail = Detail Line from the Ribbon; the line type does not
really matter, but select a continuous one via the Type Selector.

10. Draw the “vertical” line shown in Figure 3-3.3; be sure to snap to the Mzdpoint of the
atrium wall as your first point.

Next you will draw an elevator shaft, centered on the atrium and 35’-0” back (thus the temp.
line).

The inside dimensions of the elevator are: 7’-4” x 6’-10”. Because you know the inside
dimension you will want to adjust the location line to match the known info.

11. Use the Wall tool to draw Basic Wall: Genetic — 8” Masonty.

12. Set the Location 1.ine to: Finish Face: Interior.
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Office Building: FLOOR PLAN (First Floor)

13. Draw the elevator shaft.
Make sure the location
line is to the inside so your
shaft is the correct
dimension. Draw the shaft
anywhere in the Drawing
Window, you will adjust the
exact position next.

FYI: The inside dimensions are —®
listed above.

14. Select the 4 walls that
represent the elevator
shaft, and then pick the
Move tool.

o

35
1

First pick, using the
midpoint snap

168 - 07 +
- |
FIGURE 3-3.3
Temp. Detail Line

18 -0

_+
S

T1P: Concrete blocks come in varions widths, and most are 16" long and 8 high. When drawing plans there
is a simple rule to keep in mind to make sure you are designing walls to conrsing. This applies to wall lengths
and openings within CMU walls.

Dimension rules for CMU coursing in floor plans:
o 07 ore8” where ¢ is any even number (e.g., 60" or 248"}
o« 047 where 0 is any odd number (e.g., 54"

15. Snap to the Midpoint of the shaft as your first point, and then snap to the Middle
Endpoint of your temporary detail line (Figure 3-3.4). You should zoom in to verify
your snaps. Do not draw the dimensions, they are for reference only.
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The elevator shaft is now perfectly centered in the

atrium and exactly 35’-0” back from the South A
curtain wall. 7r-4
. )
16. At this point you can delete the temporary -
line. Select the line and then right-click and ) EcIJ
select delete or press the Delete key on the _ "k\
keyboard. p
,,’, First pick, using the
’,' midpoint snap

\ Second pick, snapping to

the middle of the line’s end

FIGURE 3-3.4 Move elevator shaft into place

FYI: When a wall is selected, you can see that wall’s properties via the Properties Palette (Type “PP” 1o open the
DPalette if it is not visible). Click one of the elevator shaft walls and verify that it is 3607 tall.

Modify an Existing Wall:

Next we want to change the portion of wall between the building and the East and West
stair shafts. To do this you will need to split the current wall, trim the corners and then draw
an 8” masonty wall.

17. Zoom in on the West stair shaft and select the Split tool H-
(Modify tab on the Ribbon). ot

18. Pick somewhere in the middle of the wall (Figure 3-3.5).

19. Select Modify = Edit = Trim to trim the corners so the extetior wall only occurs
at exterior conditions (Figure 3-3.0).

TIP: Select the portion of wall you wish to retain.
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Office Building: FLOOR PLAN (First Floor)
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Additional Custom Wall Types:

We decide that the stair shafts are mostly utilitarian and do not require gypsum board on the
walls. In the next steps you will create a new exterior wall type just like the one previously
created less the gypsum board and metal studs. Also, you will create a custom wall type to
close the open side we created in the previous steps. This wall type will have gypsum board
and metal studs on one side.

20. Using wall type: Basic Wall: Brick & CMU cavity wall as a starting point, create a new
wall type named Brick & CMU cavity wall (no GWB). Remove the gypsum board

and metal studs and save the new wall type. (Remember to click Duplicate.)

21. Change the three exterior walls around the west stair shaft to the new wall type
created in the previous step.
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22. Using wall type: Basic Wall: Brick & CMU cavity wall as a starting point, create a new
wall type named 8” Masonry with GWB 1S. Remove the brick, air space and rigid
insulation and save the new wall type (Figure 3-3.7).

FYI: 1t will be useful to come up with a standard naming system for your custom wall types. If the names
get to long they are hard to read. The exanmple above has:

* GWB = Gypsum Wall Board (and would inmply studs)

* 18 = finish only occurs on one side of the wall.

Function Material | Thickness
n/a n/a n/a
Core Boundary Layers above wrap 0”
Structure [1] Masonry — Concrete Masonry Units 8”
Core Boundary Layers below wrap 0”
Finish 2 [5] Metal — Stud Layer 227
Finish 2 [5] Gypsum Wall Board 78"

FIGURE 3-3.7 New wall layers

23. Draw a wall so the gypsum finish continues on the

office side, using the ~A/gn tool if necessary (Figure 3- H
3.8).
Use the Measure tool to mafke sure the stair shaft is the correct AN %<

size; don’t draw the dimensions.

Next you will use the Mzrror tool to update the east stair, but
first you will draw a Reference Plane to use as the Axis of
Reflection (more on this later while using the Mirror tool).

gl _ 4II

24. Select Home = Work Plane = Ref Plane from the
Ribbon.

1

25. Draw a Reference Plane snapped to the vertical,
centered on the South atrium wall (See Figure 3-3.9).

26. Erase the four walls of the East stair shaft; this will N
include the main east wall of the office building

(Figure 3-3.9).

27. Select the six walls at the West stair (Figure 3-3.9). FIGURE 3-3.8 Revised west stair

T1P: Make sure the count is correct on the Status Bar. ?.6
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Office Building: FLOOR PLAN (First Floor)

28. Select the Mirror - Draw Axis tool (on the Ribbon) and then select the D|
Reference Plane (Figure 3-3.9). K

Pick the
Reference Plane

|

|

|

|

|

|

as the axis of I
T~
|

|

|

1

|

reflection
|
|
|
|
|
|
|
|
|
|
|
|
|
|
I

FIGURE 3-3.9 Mirror west stair

29. Use the Measute tool to verify the overall length of the building is 140’-0”. Adjust

as necessary (see Fig. 3-2.2).

-

FIGURE 3-3.10 Mirrored west stair

Finally, you will draw a few more interior walls to compete the first floor plan. Do not
delete the Reference Plane (note: the reference line may not show up in every image in
this text).
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30. Using the Wall tool, set the wall type to:
Basic Wall: Intetior — 4 7/8” partition (1-hr)

31. Draw the additional walls shown in Figure 3-3.11. Make sure to position the walls
per the dimensions shown. Use the Measure tool to verify accuracy. Also, modify the
Location Line as required.

DRAWING TIPS: Copy the existing atrinm wall 6 “47/s” over (6“0 plus one wall thickness), draw a wall from the
midpoint of the elevator shaft with centerline reference (Location Line), and use the Trim and Mirror tools. Do not
draw the dimensions. SAVE YOUR PROJECT as ex3-3.1vt.

6'- 0"
CLEAR

6| _ OII 6| _ OII

CLEAR CLEAR

19'- 0"
CLEAR

FIGURE 3-3.11 Remaining interior walls
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Exercise 3-4:

Elevator

This lesson will show you how to insert an elevator into your elevator shaft.

Insert Elevator:

Revit provides many Fawmilies, which are predefined elements ready to insert into your
project. However, many elements are not readily available, like elevators for example. You
will get an elevator family online in this exercise. The online library is where you will acquire
an elevator family for use in your project.

1. Open project ex3-3.rvt and Save As ex3-4.rvt.

You will have to download the elevator from the web. Of course you will need to be connected to the
Internet.

2. Click on the Insert tab on the Ribbon.

3. Type in Elevator-Electric and then press Enter (Figure 3-4.1).

Elevator-Electric Eja

Find product design files online

Autodesk Seek

FIGURE 3-4.1 Insert tab; Autodesk Seek panel

Your browser will open and e =)
you will be looking at the QU+ [Brmren e EE “[Blo]x|[Een 2]
., %1 WindowsLive ing @ v © WhatsNew Profile Mail Photos Calendar MSN »‘ S\gnmJ x @snagt B &
contents of Revit’s PR S —
. stodesk Sedl B -8 -0 @ - Pager Setey~ Toos~ @~ 7
Seek.Autodesk.com website = =
: Autodesk: Seek

(Figure 3-4.2).

Search

Revit [=] elevator-electric

Autodesk Seek currently serves the U.5. AEC (architecture, engineering and construction) market
The family you searched for
. . . Content Source
is generic content provided it 1| et e
by Autodesk. However, — -
manufacturer created content kg
can also be found here. It is
ideal to use actual
manufacturer content as they
should be the correct size and

. . Done @ Internet | Protected Mode: Off 45 v H100% -

have good information stored
in them. FIGURE 3-4.2 Seck.Autodesk.com
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4. Click the 2 RFA icon highlighted in Figure 3-4.2.

You now see a larger preview of the family, in the plan view in this case (Figure 3-4.3). Next
you need to select which version of content you want to download. Revit is not backwards
compatible so you cannot download a newer version of content than the version of Revit
you have. However, you can download older content and Revit will automatically upgrade it

anytime you try using it. NOTE: The 2011 content was not posted at the time of the printing of this textbook;
it will be by the time the reader does this exercise.

-
& Autodesk Seek - Microsoft Internet Explorer

=)

@ \-:, - | http://seek autodesk.com/product/latest/adsk/revit/families/arch/empty/Revit_ARC1596%pane ~ ‘ 2 |"’| X | | Bing R 'l
% &7 Windows Live  Bing B - What's Mew  Profile Mail Photos Calendar MSN Sign in | s (& Snagit i Bt
i Favorites 3% @] Get More Add-ons = .

7|Autodask5eak |_‘ IR ~ [ d= v Pagev Safety~ Tools~ (@~ ?

Autodesk: Seek

The online source for product specifications and design files

Search
Revit

[=]

Autodesk Seek currently serves the U.S. AEC (architecture, engineering and construction) market

Elevator-Electric
Category: Electric Traction Elevators

2 files for download

New Demo Seek Using Revit (2] FAQ Discussions &3 Feedback B2 | Manufacturer Home

-

Seek User Uploads b Register Login

Powered by TURBO SEUIC

Architect ket

quality

Email this page

Download selected

Show All Files About i-drop E
ZRFA files Select All
— = Rewit 2010 Imperial File
Revit Architecture 20102010 or later one
. 224K | 3D View | Revit Family Parameters
H 4
‘n = ] Revit 2008 Imperial File
Revit Architecture 20092009
p 212K | 3D View | Revit Family Parameters
Description

Specialty Equipment: Conveying Systems i

4 -] | r

Done & Internet | Protected Mode: Off v H100% -

FIGURE 3-4.3 Web content
5. Click the box next to Revit 2011 Imperial
File. [ File Downlosd =)
Do you want to open or save this file?
6. Chck the DOWnload SeleCted button ]uSt Name:  Elevator-Electric.ia
. | Type: Revit Family, 224KB
up and to the right of the selected content. L e
Open ] [ Save ] l Cancel ]

Select Save (Figure 3-4.4).

Check the box and click accept if you agree

to the Terms and Conditions of using the
Seek website (Figure 3-4.5).
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[7] Always ask before opening this type of file

While files from the Intemet can be useful, some files can potentially
ham your computer. f you do not tnust the sourcs, do not open or
save this file. What's the risk?

9

\

FIGURE 3-4.4 Web browser prompt
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HET)
@\J' S hitp:/sseckautodesk.com/product/latest/adsk/revit/families/arch/empty/Revit_ARCL36%pane + | 2 [ 42 | x | [ 8ing o -

Sign mJ x Esnagit B =

~
& Autodesk Seek - Microsoft Internet Explorer

x £ Windows Live  Bing D ~ | What'shew Profile Mail Photos Calendar MSN

i Favorites - 5/5 2] Get More Add-ons v

|[5] Autodesk Seek \ | G- - [ b v Pagev Safetyr Tooks~ @~
Autodesk° Seek Mew Demo Seek Using Revit [E] FAQ Discussions & Feedback B2 | Manufacturer Home M

The online source for product specifications and design files Seek User Uplosds & Register Login

Search Y TURBOSEUID
Rt =
Autodesk Seek currently serves the U.S. AEC e, and market

Terms and Conditions

m

[¥]1 have read and agree to the Terms and Conditions.
Note: You need lo agree to the Terms and Conditions only ane time. Agreeing to the terms wil place a cookie on your machine that wil allow you to download content from Autodesk® Seek
every subsequent time.

Accept Cancel

© Copyright 2010 Autodesk, Inc. All rights reserved. Privacy Policy — Terms and Conditions.

Autodesk Seek is the online source for buikding product information, inciuding 30 models, 20 drawings, 4
visual images, and product specification data

& Internet | Protected Mode: Off fa v ®100% ~

FIGURE 3-4.5 Seek.com terms and conditions

D .y -
9. Save the file to the Desktop using the default =-E] Families

name provided. Annctation Symbels
Ceilings
Now that you have saved the elevator family file to the Columns
hard drive, you need to load it into your current project. Curtain Panels
Curtain Systems
10. Select Insert > Load from Library > E Curtain Wall Mullions
Load Family from the Rzbbon. Load Detail Ikems
Family Doors
11. Browse to the Deskfop and select the Elevator- Floors
Electric.RFA, and then click Open. .
Furniture
12. In the Project Browser, click the plus next to Parking
Families to expand the list (Figure 3-4.6). F'atte.rn
Planting
13. Expand the Specialty Equipment list, and Profiles
then Elevator-Electric. Railings
Ramps
As you can see, four elevator types were loaded into Roofs
your project. Similar to wall types, you can add one of - Specialty Equipment

these types as-is, or you can modify or create a new
type. Next, you will add information in the Type

= Elevator-Electric

2000 lbs
Propcim'ey dialog to better document the elevator 2500 |bs
specified. 3000 Ibs
3500 lbs

14. Right-click on the elevator type: 2000 Ibs, and
then select Type Properties from the pop-up
menu.
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You will now see a listing of the type properties for the selected elevator type.

15. Click the Preview button (if necessary) to see the graphical review of the elevator
type. Set the Zew to 3D View: View 1.

16. Add the following information (Figure 3-4.7):

e Model: MadeUp 8864
o Manufacturer: ThyssenKrupp Elevator

URL.: www.thyssenelevator.com

The three entries in step 16 are optional (although not for this exercise), but this is a great
way to better document the project. This is part of the I in BIM (Building Information

Modeling).

Type Properties

==

- Family: [EIe\rator—EIectric

'] Load...

o Lt
st Type: [2000 Ibs

+] [ oulicate... |

—L

Type Parameters

Rename...

Parameter

Value | -

Identity Data
Keynote

3

Model

MadeUp 8864

Manufacturer

ThyssenKrupp Elevator

Type Comments

www.thyssenelevator.com

[

URL

Description

Aszembly Description

m

Assemnbly Code

Type Mark

Cost

OmniClass Number

OmniClass Title

Other
Width

33

Pit Depth

Door Opening

- Depth

i &=
=1

b Cab Width

View: [3D View: View 1 v] [ Preview == J ’ 0K

] ’ Cancel Apply

FIGURE 3-4.7 Elevator properties

17. Click OK to close the open dialog box.
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18. Drag the 2000 Ibs elevator type from the Prgject Browser into the first floor plan.

The elevator type will be attached to your cursor, ready for insertion.

19. Move your cursor within the elevator shaft and adjust it until the elevator “snaps” in
place; then click (Figure 3-4.10).

20. Press Esc twice to tell Revit you are finished placing elevators.

Now you have to add an elevator door in the shaft walls at each level; this is similar to a

regular door in a wall. Like the elevator, the elevator door has to be downloaded from the
internet. You will do that next.

21. Similar to the steps previously covered, load the Elevator Door — Center family
from the Seek.Autodesk.com website (Figure 3-4.8).

. N
@ Autodesk Seek - Microsoft Internet Explorer Bl
@\_J v [[S] http://seck autodesk.com/product/latest/adek/revit/families/arch/ empty/Revit ARCI3607panel=rfs [ [4] x| [= sing o~

3 - 5
x £ Windows Live Bing .- What'sNew  Profile  Mail Photos Calendar MSN  Share | v Sign in J x @snagit B &
< Favorites  © 55 &) Get More Add-ons ~
- »
22|+ 5] Autodesk seek | (5] Autodesk Seck x| | fi - B -~ & @ - Pagew Safety~ Tools~ @~
@ This website wants to run the following add-on: ‘Autodesk Component' from 'Autodesk, Inc (unverified publisher)”. I you trust the website and the add-on and want to allow it to run, click here... x
Autodesk@ Seek New Demo Seek Using Revit (] FAQ Discussions £ Feedback B2 | Manufacturer Home B
The online source for product specifications and design files Seek User Uploads & Register Login
Search UREOSQUID
Revit
Autodesk Seek currently serves the U.5. AEC (archi engineering and ) market
Elevator Door-Center Email this page
Category: Elevator Doors 2 files for download Download selected
Show Al Files About idrop
2 RFA files Select Al
Revit 2010 Imperial File
Revit Architecture 20102010 or later one
) 192K | 30 View | Revit Famiy Parameters
(] Revit 2008 Imperial Fils
Revit Architecture 20092009 i |
4 184K 1 30 View | Revil Famiy Parameters
Description
@ Done € Internet | Protected Mode: Off 5 v H100% -

FIGURE 3-4.8 Elevator door from Seek.Autodesk.com
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[ e e

22. Drag the 36” x 84” elevator door type from the @ Faoofs
project browser into the first floor plan (Figure 3- - Specialty Equipment
4.9). El ----- Elevator Doar-Center
[ 20 4 BN
23. Place the elevator door at the center of the wall, RN
aligned with the elevator door on the cab (Figure o e xBd”
3_410) ....... 48" g4"
P 900 x 2100mrmn
TIP: If the door is inserted on the wrong side of the wall, select =l Elevator-Electric
the door and click the Control Arrows to flip it within the wall. = 2000 Ibs
....... 25':”:' |b5
....... SDI:”:I |b5
....... 35':”:' |bs
- Stairs

F- Structural Columns

FIGURE 3-4.9 Elevator doors in
Project Browser

A

VARV ARV

FIGURE 3-4.10 Elevator door added to plan

Notice when the elevator is selected, the flip icon (control arrow) is displayed. Similar to the
doors and walls, you can click this icon to flip the orientation of the elevator within the
shaft.

24. Save your project as ex3-4.rvt.
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Doors and Windows

This lesson will take a closer look at inserting doors and windows.

Insert Doors:

Revit has done an excellent job providing several different door families. This makes sense
seeing as doors are an important part of an architectural project. Some of the provided
families include bi-fold, double, pocket, sectional (garage), and vertical rolling, to name a
few. In addition to the families found on your local hard drive, many more are available via
Seek.Autodesk.com as well as other internet sites (some free some not).

The default template you started with only provides the Sgl Flush (Single Flush) group in
the Doors category. If you want to insert other styles you will need to load them from the
library. The reason for this step is that, when you load a family, Revit actually copies the data
into your project file. If every possible family was loaded into your project at the beginning,
not only would it be hard to find what you want in a large list of doors, but also the files
would be several megabytes in size before you even drew the first wall.
You will begin this section by loading a few additional families into your project.

1. Open project ex3-4.rvt and Save-As ex3-5.rvt.

2. From the Insert tab, select the Load Family button on the Ribbon (Figure 3-5.1).

3. Browse through the Imperial Library folder for a moment.

o

EHO-R-0-2- A0 A G- 5 -

Insert

b B2 C) O % B R (3 &l

Medify| Link Link DWF  Decal Manage |Import Insert Image Manage
Revit CAD Markup M Links CAD  from File”

| Select | Link | Import

Properties [=]

i o e _‘*ﬂ-h‘-h- TR VY MJLM‘,.‘.,‘_‘#‘.*-’

FIGURE 3-5.1 Load Family
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Each file represents a Family; next you will load four door Families into your project
(Figure 3-5.2).

[ R Load Family L2 ez |
Look in: [ | Doors, v] & ¥ OEY views =
- Preview
I*_E Nare Date modified Type Size i
= [ Bifold-2 Panel 3/26/2010 .08 PM  Revit Family 228 KB
My Computer EBifDId-d Panel 3/26/2010 7:08 PM  Revit Family 252 KB
- |ECurtain Wall Dbl Glass 3/26/2010 7:08 PM_ Revit Family 220KB |=
@Curtain Wall 5gl Glass 3/26/2010 7:08 PM Revit Family 200 KB o
E(urtaln Wall-Store Front-Dbl 3/26/2010 7:08 PM Revit Family 232 KB
=i Double-Flush 3/26/2010 7:08 PM Revit Family 204 KB
Double—FIush—DbI Acting 3/26/2010 7208 PM Revit Family 208 KB
EaDouble-Glass 1 3/26/2010 7208 PM Revit Family 220 KB
@Double-ﬁlass 2 3/26/2010 7208 PM Revit Family 260 KB
Double-PaneI 1 3/26/2010 T:08 PM Revit Family 228 KB
@i Double-Panel 2 3/26/20107:08 PM  Revit Family 236 KB
[ Double-Uneven 3/26/20107:08 PM  Revit Family 204 KB
@Opening{ased 3/26/20107:08 PM  Revit Family 204 KB
@Opening-EHipt\(a\ Arch 3/26/20107:08 PM  Revit Family 192 KB
@Overhead-Rolling 3/26/2010 7:08 PM Revit Family 200KB ~
« T | »
File name:  Curtain Wall Dbl Glass -
Fies of type: (Al Supported Files (*.rfa, *.adsk) -]
: L oo | [ cond ]
S ——————————

FIGURE 3-5.2 Door families on hard drive

4. Select Curtain Wall Dbl Glass.tfa, and then click Open. (Figure 3-5.2)

5. Repeat steps 2 — 4 to load the following door families:
a. Double-Glass 1
b. Sidelights 1 B@ Families
c. Single-Glass 1 ;

Annotation Symbols
-Ceilings

-Columns

-Curtain Panels

- Curtain Systems

- Curtain Wall Mullichs

6. In the Project Browser, expand Families and Doors
to see the loaded door families (Figure 3-5.3).

If you expand a door family itself in the Project Browser
you see the predefined door sizes associated with that
family. Right-clicking on a door size allows you to
rename, delete or duplicate it. To add a door size you
duplicate and then modify properties for the new item.

-Curtain Wall Dbl Glass
-Double-Glass 1
-Single-Flush

L Single-Glass 1

Next you will insert the doors into the stair shafts. | = g Floors

FIGURE 3-5.3 LLoaded door families
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7. Select the Door tool from the Home tab and then pick Sgl Flush: 36” x 84” from the
Type Selector on the Properties Palette.

8. Insert two doors in the West stair shaft as shown in Figure 3-5.4. Remember you are
inserting a door into a masonry wall so your door position and size need to work

with coursing. Thus the 8” dimension (however, you would also need to include the
door frame into the equation).

9. Repeat the previous step to insert doors into the East stair shaft.

10. Finish inserting doors for the first floor (Figure 3-5.5).
Use the following guidelines:

a. All doors should be 36” wide and 7°-0” tall.

b. You will not insert doors into the curtain wall for now. You will do that in a
later lesson when you design the curtain wall.

c. Use the style and approximate location shown in Figure 3-5.5.

d. Doors across from each other in the two atrium walls should align with each
other.

T1pP: While inserting the second set of doors, watch/ wait for the reference line to show up,
indicating alignment.

e. Place doors approximately as shown, exact location not given.

FIGURE 3-5.4 Doors in West stair shaft
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«

= ’

Trim Projection Ext

Trim Projection int

Trim Width

weeawa
QUUIRIRISIN

Width

Rough Width

Rough Height

Identity Data
Assembly Code

1 C1020

Kevnote

View: (3D View: View 1 =

[ Preview>> | | oK

J [ cancel

Apoly

FIGURE 3-5.6 Door properties
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P AN
Single-glass 1 / “
ingle-glass Single-glass 1
gle-g T ‘\ [ gle-g
Sgl. Flush
10 "
L1
H K
@
Double-glass 1 [— © «—| Double-glass 1
[ 3 )
@
%
FIGURE 3-5.5 First floor with doors
e Properts ==] | Door Properties:
s Fetr (o DyET— If you select Type Properties while
=i Type: [36'x 84 v] [ Duplicate. .. ] . .
the Door tool is active
N [mme ] (selected), you can modify
Parsmeter Value |8 various properties related to the
Wall Closure By host 3 door.
Construction Type
Function Interior
o [ — ok You can easily add another
Frame Material ‘Door - Frame :
alitean » stam.iard door size to 'Fhe
e i Family as required. Click

“Duplicate,” type a name
(Figure 3-5.6).

Standard doors sizes (and
Families) can be added to your
template file, so you don’t have
to load them for every new
project.
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Insert Windows:

Adding windows to your project is very similar to adding doors. Like the doors, the template
file you started from has one family preloaded into your project, the FIXED family. Looking
at the Type Selector drop-down you will see the various sizes available for insertion. At this
point you should also see the SIDELIGHT family that you loaded in the previous exercise.
First, you will add a few interior borrowed lights using the sidelight family.

Interior Windows (Borrowed Lights):

11. With the Window tool selected,

pick: Sidelights 1 :18” x 84” from
the Type Selector.

N
O

12. On the West side of the atrium,

insert the borrowed lights as

e 15)
add the dimensions. //_’

2 _3”

W

shown in Figure 3-5.7; do not

Make sure the borrowed light frames are
flush with the atrium side of the wall.
You can control that option by moving
your cursor to the side of the wall you
want the frame flush with before clicking \

to insert. After drawing the window, you

1! _ 6”
3! - Oll

can select the frame and use the flip icon {0
(similar to doors and walls). [
<
13. Repeat the previous steps to 1 5

insert the borrowed lights on the
East side of the atrium.

FIGURE 3-5.7 Sidelights added
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Exterior Windows:

14. Using the methods previously covered in this book; create a new window size in the

FIXED family. Create: Fixed: 32" x 48”. You are creating this new size to fit coursing
in the plan view. The largest window (preloaded) that fits coursing in the plan view is

247,

15. Adjust the sill height for your new window size to fit within coursing as well. Set the
sill height for Fixed: 32” x 48” to be 3’-4” (Figure 3-5.8).

Type Properties ﬁ
- Family: [Fixed '] Load...

._'.:acr: i e [32.1 s v] [ Duplicate. .. ]

Rename...

Parameter | Value ‘:
Construction %
Wall Closure iByhost I
Construction Type

Type Parameters

»

Materials and Finishes

i Glass Pane Material Glass
L [ sh Miateriai i Sash
Dimensions
Height

Drefault Sill Height
Width

Window Inset
Rough Width
Rough Height
Identity Data
Assembly Code B2020100
Keynote
Model

m

»

anwe
omag

»

Manufacturer
< ™ v
Twvoe Comments

View: [30 View: View 1 v] [ Preview == ] [ Ok ] [ Cancel ] Apply

FIGURE 3-5.8 Added window size

16. Insert the window as shown in Figure 3-5.9. The window should be inserted with
masonry coursing in mind.

INOTE: The dimensions displayed while inserting the window will not work as displayed for coursing

becanse Revit is measuring from the center of the adjacent exterior wall. Thus, you will have to insert the
window as close as possible and adjust its location, verifying with the Measure tool.
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Array Window:

The A 1 all ickl
e Array tool allows you to quickly copy @ @

several objects that have the same distance
between them. You will use Aray to copy
the windows:

17. Click the Modify tool and then select your

window.

18. With the window selected, pick the
Array tool from the Modify tab.

oo
oo

19. In the Options Bar, type 6 for the
Number field.

20. Click the left mouse button at

the midpoint of the window and
move your mouse to the FEast until

the dimension displayed is 8"-6". 3.4 1
A L

21. You should now see the windows arrayed in the

’on. . . FIGURE 3-5.9 Exterior window
wall. 8°-6" is not coursing, so select the Activate

Dimensions button on the Op#ions Bar and then
enter 8’-8” in the displayed dimension to adjust
the window openings. This allows you to more
accurately adjust the dimensions.

FIGURE 3-5.10 Window to be arrayed

FIGURE 3-5.11 Window after array
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[ e e

22. Set the windows up on the three remaining walls of the first floor (Figure 3-5.12).
Consider the following:

a. 'This would be a good use for the Mzrror tool.

b. If you need to create a temporary wall for a mirror reflection axis, make sure
the temporary wall is set to centerline.

c.  You can use the Reference Plane to mirror the windows in the East West
direction.
Use the Measure tool to verify accuracy.

e. Use the Ctrl key to select multiple windows.

ey e e ey e [ {:! i 1|-“n’ N [eeew] peee o] e e
Al
3
e o
=
]

FIGURE 3-5.12 Completed window layout

Cleaning House: - Wind'_:'WS
= Fixed
As previously mentioned, you can view the various Families and 16"« 24"
types loaded into your project. The more Families and Types you 16" = 48"
have loaded the larger your project file is, whether or not you are 16" w 72"
using them in your project. Therefore, it is a good idea to get rid of F TRt A
any door, window, etc., that you know you will not need in the 241 42"
current project. 24“ " ?2“
32"« 48"
3" x 24"
23. In the Prgject Browser, navigate to Families =2 Windows = ::”:; i "j'H
Fixed. Right click on 36” x 48” and select Delete. , 3_5 gk
+- Sidelights 1
FIGURE 3-5.13 Project Browser
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Self-Exam:

The following questions can be used as a way to check your knowledge of this lesson. The
answers can be found at the bottom of this page.

1.

2.

The Options Bar allows you to set the height of a wall when first drawing it. (T//F)

It is not possible to draw a wall with the interior or exterior face of the core as the
reference point. (T/F)

Elements cannot be moved accurately with the Move tool. (T/F)

The tool, in the Ribbon, has to be selected in order to select an element in
your project.

A wall has to be to see its flip icons.

Review Questions:
The following questions may be assigned by your instructor as a way to assess your
knowledge of this section. Your instructor has the answers to the review questions.

1. Revit comes with many predefined doors and windows. (T/F)

2. 'The length 3’-8” is a masonry dimension. (T/F)

3. You can delete unused families and types in the Project Browser. (T/F)

4. Itis not possible to load families and types from the internet. (T/F)

5. Itis not possible to select which side of the wall a window should be on while you
are inserting it. (T//F)

6. What tool will break a wall into two smaller pieces?

7. The tool allows you to match the surface of two adjacent walls.

8. Occasionally you have to draw lines (or walls) to use as a reference
point for another object or as a reflection mirror.

9. You can use the tool to copy an element multiple times in one
step.

10. The file has a few doors, windows and walls preloaded in it.

SELF-EXAM ANSWERS:
1-7T,2-F,3-F, 4—Modify, 5 — Selected
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